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SEMINAR OUTLINE
Introduction to Modeling and Analysis with FEMAP v11.3

Welcome! This seminar is intended for new and experienced FEMAP uses alike. The goal is to
provide clear and concise instructions for installing and configuring FEMAP v11.3. Once the
software is installed and the license file is located, we will walk through some basic modeling
and analysis techniques while sprinkling in new features and some classic tips and tricks. Next,
we will tackle an assembly with advanced modeling, meshing and post processing techniques.

Who are Predictive Engineering and Applied CAx?

Predictive Engineering is a 20+ year engineering consultancy that specializes in finite element
analysis using FEMAP, NX Nastran and LS-DYNA. We are simulation engineers that have built
hundreds of FEA models that have been validated in test and in long term service. Our
practice spans from satellites to mining equipment to submarines. We are generalists that can
leverage expertize from diverse sectors to provide new insights to our clients.

Applied CAx is a Siemens PLM Software value-added-reseller that is focused on delivering the
industry’s highest level of technical support for the software that they advocate. Predictive
Engineering is a co-owner of Applied and provides first line technical support, training and
startup services to Applied’s CAE clients (e.g., FEMAP, NX Nastran, NX Adv CAE).

Vi

SN Basics of Composite Modeling for Engineers
Applled CAXx FEMAP Symposium, Boeing’s Future of Flight, May 19, 2016

We do this every day

Page 2 of 19



1. INSTALLATION

Copy the files from the USB drive to your computer. Unzip FEMAPv113 _ML.zip and open the
file folder. Run setup.exe.
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14 items
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# Quick access Name Date modified
. X Localization 4/20/2016 8:29 AM
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S This PC
SentinelDriver 4/20/2016 8:26 AM
‘ Network VisQ 4/20/2016 8:25 AM
.| 0x0409.ini 10/1/2014 10:41 AM
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H ISSetup.dll 5/2/2016 1:50 PM
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FEMAP v11.3 - InstallShield Wizard FEMAP v11.3 - InstallShield Wizard X

Preparing to Install...
Welcome to the InstallShield Wizard for FEMAP
vii.3

FEMAP v11.3 Setup is preparing the InstallShield Wizard, which
will guide you through the program setup process. Please

wait The InstallShield Wizard will install FEMAP v11.3 on your

computer. To continue, click Next.

Preparing to Install...

FEMAP v11.3 - InstallShield Wizard X

FEMAP v11.3 - InstallShield Wizard X

Choose Destination Location

Select folder where setup will install files. \

Setup will install FEMAP v11.3 in the following folder.

License Agreement

Please read the following license agreement carefully.

P

This software and related documentation are proprietary to Siemens Product Lifecycle A
Management Software Inc. and/or its affiliated companies ("Siemens PLM") and are To install to this folder, click Next. To install to a different folder, click Browse and select
protected by copyright and other intellectual property laws. Your rights are defined by the et (R,

Siemens PLM End User License Agreement which you may view at:
<http://www.plm.automation.siemens.com/en us/products/eula/>

Please print out a copy of the Siemens PLM End User License Agreement for your proof of
license and keep it in a safe place. If you do not have access to this website, please call
our customer service hotline at (714) 952-5444 or toll-free in the United States at (800)
955-0000 and a copy of the Siemens PLM End User License Agreement will be sent to you.
If you do not agree with the terms of the Siemens PLM End User License Agreement, you
should promptly return the software and any related materials along with proof of purchase
to Siemens PLM or the authorized dealer from whom you obtained it for a full refund. You

acknowledge that you have read the Siemens PLM End User License Agreement, v
Destination Folder
(® I accept the terms of the license agreement Print
i = C:\FEMAPv113\ Browse...
(1 do not accept the terms of the license agreement
InstallShield InstallShield

< Back Next > Cancel < Back Cancel
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FEMAP v11.3 - InstallShield Wizard
Select Features

Select the features setup will install. \

Select the features you want to install, and deselect the features you do not want to install.

FEMAP Description
NX Nastran Installs FEMAP's Main Files
Examples
[MHelp

[IThermal and Flow Solvers
[[Jstructural Analysis Toolkit
DSolid Edge Connection
[CJFLEXIm License Manager
MvisQ

2.79 GB of space required on the C drive
312.86 GB of space available on the C drive

InstallShield

< Back Next > Cancel

FEMAP v11.3 - InstallShield Wizard

Setup Type
Select the setup type that best suits your needs.

r.

Select FEMAP GUI Language

@ English
QO simplified Chinese
(O Traditional Chinese
O German

(O Japanese

InstallShield

FEMAP v11.3 - InstallShield Wizard
Setup Type
Select the setup type that best suits your needs.

r.

Select Licensing Method

(O Nodelocked Dongle - Rainbow SuperPro

@n

(O Node-Limited Demo License

InstallShield

< Back Next > Cancel

FEMAP v11.3 - InstallShield Wizard
Ready to Install the Program

The wizard is ready to begin installation. \

Click Install to begin the installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard.

InstallShield

Applied CAx
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FEMAP v11.3 - InstallShield Wizard

FEMAP v11.3 - InstallShield Wizard

Choose Destination Location

Select folder where setup will install files. \

Femap with NX Nastran requires a scratch directory for the Nastran solver

FEMAP Installation

FEMAP Installation is now complete.
Select Finish to Exit.

Browse...

InstallShield

Cancel

Femap with NX Nastran X

@ Unable to Get License - Setup Floating or Nodelocked Licensing

You have configured FEMAP to use FLEXIm licensing. To complete the configuration

you must specify either the path to a valid license file or the name of a network
license server (as @ServerName).

Following this message, the Network License Information dialog will be displayed
where you can complete your configuration.
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2. LICENSING

Copy the license.dat file to a new folder in the FEMAP directory.

a Network License File

1 > This PC » Local Disk (C:) > femap-license v O

Search femap-license

Organize ~ New folder

| -

v

s Quick access
>  © Creative Cloud Files
> & OneDrive

> BThisPC

License.dat

> & Network

v

*§ Homegroup

m @

X Network License Information

License Information

0

License File | C:\femap-license\License.dat

[

Current Usage

‘ Show Licenses

Local HostID:
‘ Show Users

"4e3263e8cfde f8cab832c85¢ a434d9165a90" ‘

| DISK_SERIAL_NUM=10a29b17 ‘
\ COMPOSITE=99E867BB5296 \

File name: |*.dat v| ‘FIexLM License (*.dat)

e ‘

o

oK
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 File Tools Geometry Connect Model Mesh Modify List Delete Group View Window Help

NizHdLREEEE g Ol EEe: w ol Elallm]wl = (=1 2 A0S 2]E 0 B S B hcustom Tools GhUser Tools |

T S RS

4 solid Blanker |

LaTop 4Right fa Front $* Bottom &, Left §* Back fi Isometric {7 Dimetric fr Trimetric | F25 &2 208 | ] s T Bl | S 2 11 1) ¥ s wreRanillE HEABHA #8688
Model Info ox _ Untitled
DT ‘
4 Coordinate Systems
0 Geometry
+'& Connections
+/% Aero Model
% Model
% Analyses
+s) Results
+ T Views

® Groups
2 Layers

® Selection List

Femap with NX Nastran X

0‘ A license has been obtained. Press OK to continue.

i Model Info|a Meshing| & PostProcessing|

Entity Info
@ |Opening File C:\femap-license\License.dat.
@ Loading Parasolid Geometry Engine.
‘(E Femap with NX Nastran Version 11.3.0
Copyright © 2016 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.
Full OpenGL Hardware Acceleration (Double Buffered)
Your card supports OpenGL 4.5
Waiting for a liense ...
Ready Prop: 0 Ld: 0 Con:0 Grp:0 Out: 0
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3. YOUR FIRST FEMAP MODEL

& Femap with NX Nastran - [Tube Clamp.modfem : default]

IR Eh R TG R TS TS it

2| Model Info 2

" Eile Tools Geometry Connect Model Mesh Madify List Delete Group View Window Help

| $4Top $Right § Front $* Bottom & Left § Back B lsome c ferTrimetsic |

e e < ]

—~ Analysis Workflow:

[4) 8]£[€| 0. B 15 & | ghcustom Tools (hUser Tools |

dB dfe,.Tube Clamp.mo..

) al.
P THE L LFLSIWE L RY 2 W e B il FkEHRB B E® 86 E Il [isdsankel]

PIXICTr.3

414 Coordinate Systems A
0 Geometry

+/4 Connections

1% Aero Model

[1onuon sishieuy uensen xi

©41.7075-T651 Al Plate 25-5
4.2.7075-T651 Al Plate 25-5
=1 Properties
e 1..Aluminum Solid
v/® 2. API Fastener
S Layups
=4 Loads
= 1..Untitled
- Load Definitions
#1.100 Ibf Load
> Body Loads
I+ Other Loads
= 2 Constraints
=& 1..Untitled
% Constraint Definitions o

A,

=Model Info|aMeshing |

| Entity Info 2=

Select an Animated View

Curve 37
MeshFlem = 13
27 Node(s)

sabessam

Ready - Nodes: 17520, Elements: 10546

Activate an Output Set
Select an Undeformed View
Select a view with no Contours
Save Model

Saving Database.

View Visibility

 Copy Picture

Prop: 1 Ld:1 Con:1 Grp:0 Out:2

Geometry
Material
Property
Mesh Sizing
Meshing
Loads
Constraints
Analyze

Output Set: NX NASTRAN Case 1
Deformed(0.00398): Total Translation
Elemental Contour: Solid Von Mises Stress

30000.

28125,

26250

24375.

22500.

20625.

18750.

16875.

15000.

13125.

11250.

9375.

7500.

5625.

3750.

1875.
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3.1 GEOMETRY
File > Import > Geometry

Solid Model Read Options

Title

Entity Options
Geometry Scale Factor

Layer

Update Existing Geometry

(® Colors From File
O Active Colors
(O Single Color

Assembly Options

OK

‘ 39.37
\ 1
Options..
92 Palette...

[ ]Increment Layer Increment Color

Cancel

Applied CAx
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3.2 MATERIALS
Model > Material > ISOTROPIC (7075-T651)

Define Material - ISOTROPIC X
B " Select From Libra O X
D1 | Title| 7075-T651 Al Plate 25~  Color 104 | ] Palette...  Layer T Y
Library Entry Choose Library...
General Function References Nonlinear Ply/Bond Failure Creep Electrical/Optical Phase
Stiffness Limit Stress 'AISI 4340 Steel
Youngs Modulus, E | 10300000. ‘ Tension | 66000. | éts)éip1lj3§t1amlislstng!2555
- ate .25-.
Shear Modulus, G [ 0. | Compression | 67000. | 6061-T651 Al Plate .25-2.
o ) 7050-T651 Al Plate .25-.5
Poisson's Ratio, nu | 0.33 | Shear 43000, | 7075-T651 Al Plate .25-5
Ti-6Al-4V Sol Tr & Aged .
Thermal AISI 1025 Carbon Steel
. AISI 4130 Steel
Expansion Coeff, 2 l 12385 ‘ Mass Density l 2.59062E-4 ‘ Stainless Steel Annealed
Conductivity, k 000201389 \ - Magnesium AZ31B
Specific Heat, Cp [ 77.28 | Demerne e ‘ Treniom, Pre
Heat, . itanium, Pure
. Reference Temp ‘ 70. ‘ A286 HRES Iron Alloy
Heat Generation Factor Hastelloy X
Inconel 600
Rene 41
Beryllium
Beryllium Copper
Nonlinear
FuncDep
Values in Library files distributed with FEMAP are believed to be correct but have not been verified. You
must verify these values are correct and appropriate before using them for any purpose.
a || % Delete OK Cancel
fy Save... Copy... oK Cancel

\5)
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3.3 MESH SIZING
Mesh > Mesh Control > Size on Solid

Entity Selection - Select Solid(s) to Set Mesh Size ?
+ 111 ] ;
@Add  ORemove (O Exclude + 111 Select All Reset Pick A
DI Jfsje] &1 ] N [ - o
)|
Group More Method # Cancel
Automatic Mesh Sizing X

Size For
@®Tet Meshing (O Hex Meshing
Basic Curve Sizing Surface Interior Mesh Growth

Element Size 0.0485241 [JGrowth Factor 1.

Curvature-Based Mesh Refinement

[IRefinement Ratio 0.1

[“1Replace Mesh Sizes on All Curves
Min Elements on Edge

Refine Surface Mesh

Assembly / Multi-Solid Sizing
N

[J Adjacent Surface Matching

Max Angle Tolerance

Max Elem on Small Feature

[[IMax Size of Small Feature 0.0485241 Remove Previous Slaving
[[]Vertex Aspect Ratio 3. Adjust Colors

] suppress Short Edges |1—| " [ Skip Sizing on Slaved Surfaces
[]Auto Boundary Small Surf i %

[ Mapped Meshing Refinement

Sizing Type  2..Parametric/Equal Length v Cancel

Applied CAx
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3.4 MESH SIZING

Mesh > Geometry > Solid

Applied CAx

We do this every day

Automesh Solids X
Node and Element Options
Node ID CSys ‘ 0..Basic Rectangular v Node Param... Elem Param...
Elem ID Property vilx Options...
Mesh Generation
[JSurface Mesh Only [[]Multiple Tet thru Thickness 2 Merge Nodes 0..Off N
Allow Mapped Meshing Tet Sliver Removal Tet Optimization 3..Default v
Midside Nodes Tet Growth Ratio tol
Update Mesh Sizing... OK ‘ Cancel
Z
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3.5 CONSTRAINTS
Model > Constraint > On Curve

Create Constraints on Geometry X

Constraint Set 1 Untitled

Title | Bolted Constraint

Coor (20| polettec. Loy _

Standard Types
(®Fixed
(O Pinned - No Translation
(O No Rotation

Advanced Types
O Arbitrary in CSys -1..Nodal Output CSys v

(1™ [y [z [JrRx [JrRY []RZ

() Surface | Include Rotational DOF
() Allow Sliding only along Surface (Symmetry)
() Allow Movement Normal to Surface (AntiSymmetry)
() Allow Sliding only in Specified Direction

() Cylinder / Hole

| Constrain Radial Growth
Constrain Rotation around Axis

.| Constrain Sliding along Axis
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3.6 LOADS

Model > Load > On Surface

Create Loads on Surfaces

Load Set 1 Untitled

Title \ 100 Ibf Load

| Coord Sys ‘ 0..Basic Rectangular

Color | 10 Palette...

Layer |1

O Direction Method
~
Force Per Area (® Components (® Constant
Force Per Node .
Bearing Force O Vector O Variable
Moment (O Along Curve (O Data Surface
Moment Per Area O Normal to Plane
Moment Per Node T e e ‘ —d ced ‘
Torque (O Normal to Surface Specify... Advanced...
Displacement
Enforced Rotation Load
Velocity Value Time/Freq Dependence Data Surface
Rotational Velocity X [ 0. 0..None v | | 0.None v |
Acceleration | l |:
Rotational Acceleration FY 0..None v |
Pressure
Temperature
Element Temperature
Heat Flux Phase | 0. | 0..None
Heat Flux Per Area
Heat Flux Per Node Midside Node Adjustment
Heat Generation v T | OK | ‘ Cancel
= Uecs Cl... otal Load
= A Basics of Composite Modeling for Engineers Page 15 of 19
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3.7 ANALYZE
Model > Analysis (36..NX Nastran, 1..Static)

B " Analysis Set Manager (Active: 1.NX Nastran Static ... O X
E3 Analysis Set : 1..NX Nastran Static Analysis Set|
Analyze
Analyze Multiple... (B Analysis Set X
= Title NX Nastran Static Analysis Set| |

W‘ Analysis Program | 36..NX Nastran v |

e Analysis Type | 1..Static v
Gy ‘ Solve Using
Delete ‘ (® Integrated Solver

Renumber... ‘ (O Linked Solver

Load Solver is undefined. Go to File Preferences Solvers.
Save... OMISQ

New... | Next... OK ‘ ‘ Cancel
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3.8 POST PROCESSING
Post Processing Toolbox (Contour, Deform)

, PostProcessing Tool
o2 BRk-8-0-(383

, PostProcessing Tool
o2 ORk-8-0-(383

Deform

Deformed 30000,
Style Contour
Output Set 1.NX NASTRAN Case 1 « @ » 28125. Results
QOutput Vector 1.Total Translation « [ » Output Set 1.NX NASTRAN Case 1 « @

26250.

Options Output Vector 7033..Plate Top VonMises St « [{}] =
Transform None 24375. Additional Vector(s) =]
E| Actual Deformations 22500. Options
Scale Actual By 1 Transform
Scale Based on Group 0 20625. Data Conversion Average
Deform Relative To Origin 18750. Data Selection Contour Group

Deformed Model
Undeformed Model

-l Type Elemental
Double-Sided Planar
15000. Show On Groups Full Model / Visible Groups
Show As Filled

0 16875.

Contour

Freebody
13125. - Levels
11250, = Level Mode Max Min
Maximum Level 30000.
8375 Minimum Level 0.
7500. Contour Palette Standard Palette
# of Levels 12
5625. Continuous Colors [}
3750. Animate
X Label Max/Min No Labels
1875.
Legend
Output Set: NX NASTRAN Case 1 0
Deformed(0.00398): Total Translation : m Eraahad
Scale Elemental Contour: Solid Von Mises Stress Contour

Sets the Scale for the Deformation Output Vector. Default is % of Model, which

‘&l Model Info | @l Meshing | [@ PostProces:

Tool for controlling Contour, Criteria, Beam Diagram, IsoSurface, Section Cut and

Lo
sing\
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3.9 BONUS MESHING

Custom Tools > Meshing > Hole to Hole Fastener

Data Table
Element Update
Event Callback
Examples

File Processing
GeometryProcessing
Grouping

Honeycomb PSHELL

Import then Connect Startup
Load Processing

Meshing

Model Query

Node Update
PostProcessing
SolidConnectionTools
Standard Analysis

Auto Boundary Faces With Poles

Combine And Mesh Surfaces By One Curve
Combine And Mesh Surfaces

Compression Only Gaps

Connect Nodes On Surfaces With Rigid Elements
Copy Nodes With Increment

% Tools Directory...

Views Create Grounded CBUSH Elements
Visualization Hole To Hole Fastener

=3 Stop API Tool Merge All Nodes

& | Add Tools... Move Merge Nodes

Multi DOF Springs from single DOF Spring
Multi Mass Elements

Multi Single Node Elements
ShowBadTetras

ShowWorstElem

Spider Curves

Spider Nodes

Spider Surfaces

Spider

AppliedCi
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Thank You

Predictive Engineering is located in Portland, OR

PredictiveEngineering.com
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